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ВВЕДЕНИЕ 

 
Для выполнения представленных практических работ предлага-

ется использовать САПР − систему автоматизированного проектиро-
вания Advanced Design System, которая  предназначена для моделиро-
вания аналоговых и цифровых радиоэлектронных устройств и систем 
широкого класса. Ниже приводится последовательность основных ко-
манд, ориентированных на сеанс работы с программным обеспечением 
данной САПР. 

1. Запустить программу Advanced Design System. Сгенерирует-
ся окно главного меню. 

2. Установить режим работы системы - аналоговый, если это не-
обходимо, выполнив команду Tools> Advanced Design System Se-
tup>Analog RF Only. Выйти из программы и снова ее запустить. 

3. Создать новый проект с помощью команды File>New Project. 
4. Присвоить имя новому проекту и открыть его. К имени авто-

матически присоединяются символы _prj. 
5. Открыть окно схемного редактора командой File>New Sche-

matic. 
6. Сформировать схемный проект. 
7. Сохранить содержимое окна схемного редактора. Файл получа-

ет расширение *.dsn и размещается в подкаталоге network. 
8. Результаты моделирования (графики, таблицы и т.п.) сохра-

нить в файле с расширением *.dds. 
В издании приведено описание методики выполнения  заданий к 

практическим занятиям, ориентированным на изучение способов ав-
томатизированного расчета основных характеристик типовых трактов 
радиоприемного устройства (преселектора, смесителя, тракта проме-
жуточной частоты, супергетеродинного приемника) с использованием 
современных методов линейного и нелинейного анализа. 
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Практическая работа № 1 
 
 

ИССЛЕДОВАНИЕ УСИЛИТЕЛЯ ВЫСОКОЙ ЧАСТОТЫ 
 
 

Цель работы: освоение методики автоматизированного иссле-
дования характеристик усилителя высокой частоты (УВЧ) радиопри-
емного устройства (РПУ). 

 
 
Основные рассчитываемые параметры:  
− амплитудно-частотная характеристика (АЧХ); 
− односигнальная избирательность по побочным каналам приема; 
− коэффициент шума; 
− спектр выходной мощности; 
− динамическая характеристика и точка компрессии (Р1дБ); 
− точка интермодуляции 3-го порядка (TOI). 

 
 

Основные используемые методы и виды анализа: 
− малосигнальный анализ (AC); 
− шумовой анализ в малосигнальном  режиме; 
− анализ методом гармонического баланса при одночастотном и 

двухчастотном воздействии. 
 

 
Пример выполнения этапов исследований 
Ниже приведены примеры выполнения оценок основных харак-

теристик УВЧ, представленного в виде функционального блока или 
макромодели. 

 
 

Пример расчета коэффициента передачи методом малосиг-
нального анализа 
На рис.1 приведена схема проекта, который можно найти в 

директории Examples/Tutorial/SimModels/network в файле SP1.dsn. 
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Для выполнения моделирования необходимо использовать контрол-
лер анализа S-параметров (S-parameter), в котором устанавливаются 
границы частотного диапазона (от 800 до 900 МГц) и шаг (1 МГц)  
при проведении анализа. 

 

 
Рис. 1. Схемный проект для анализа S-параметров УВЧ (S21) 

 
Результаты расчета АЧХ в децибелах приведены на рис. 2. Из не-

го можно сделать вывод,  что коэффициент передачи усилителя в пре-
делах  диапазона частот меняется от 13, 3 до 12,5 дБ. 

 

 
 

Рис. 2.   Модуль коэффициента передачи УВЧ 
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Анализ коэффициента шума УВЧ  в линейном режиме  
При моделировании можно учесть следующие шумовые источники: 
− температурные шумы пассивных элементов с активными поте-

рями; 
− шумы линейных активных приборов, представляемых в виде  

четырехполюсника, описываемого файлом данных; 
− шумы от внешних источников шума; 
− тепловые шумы, генерируемые паразитными сопротивлениями 

потерь модели активных элементов; 
− шум канала для полевых транзисторов (JFET-, MOSFET- HEMT- 

структуры);   
− дробовые шумы, обусловленные токами, протекающими через 

переходы, которые моделируются для диодов и биполярных транзисто-
ров (зависят от токов смещения и не зависят от температуры); 

− фликкер (1/f) шум, который моделируется для большинства ак-
тивных приборов; 

− шум (Burst) низких частот, зависящий от смещения и модели-
руемый для биполярных транзисторов. 

Для проведения анализа необходимо выполнить установки  па-
раметров для оценки коэффициента шума в контроллере S-Param, как 
показано на рис. 3. 

 
Рис. 3. Установка параметров для анализа коэффициента шума 
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После проведения анализа в списке выводимых параметров ко-
эффициент шума будет соответствовать идентификатору nf(2) и из-
меряться в децибелах. Перед этим необходимо убедиться, чтобы во 
всех резистивных элементах схемы была включена опция Noise=Yes. 
В противном случае их вклад в формирование шумового напряжения 
на выходе учитываться не будет. 
 
 

Спектральный анализ УВЧ при фиксированной мощности вход-
ного сигнала 
Ниже приведен пример подготовки схемного проекта для спек-

трального анализа методом гармонического баланса. Для этого необ-
ходимо выполнить следующие действия: 

1. Сформировать в окне редактора схему усилителя (рис.4). 
В данном случае это функциональная модель с параметрами: 

S21= 20 db (коэффициент передачи); 
TOI=20 dbm (точка интермодуляции 3-го порядка); 
SOI=30 dbm  (точка интермодуляции 2-го порядка). 
Вместо параметров TOI и SOI можно задать точку компрессии 

(P1dB).  

 
 

Рис. 4.  Задание параметров модели усилителя 
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Если в состав схемы входят дискретные активные элементы (дио-
ды, транзисторы), то при их параметризации необходимо использовать 
только нелинейные модели. 

2. Выбрать источник мощности сигнала Component Palette 
List>Sourses_Freq Domain>P_1 Tone и разместить на схеме со сле-
дующими установками: 

P = -30 dbm; 
Freq = 0.5 GHz (рис. 5). 

 

Рис. 5. Подключение источника входной мощности 

3. Подключить к выходу Term-компоненту из группы Simulation-HB. 
Командой Name Node присвоить имя выходу схемы (Out) (рис. 6).  

 
Рис. 6. Подключение сопротивления нагрузки 
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4. Разместить контроллер метода гармонического баланса Component 
Palette List>Simulation-HB>HB, сделав следующие установки (рис. 7): 

Order = 5 (количество учитываемых гармоник); 
Frequency = 0.5 GHz (базовая частота, соответствующая частоте 

входного сигнала). 
 

 
Рис.7. Подключение контроллера анализа 

 
5. Запустить проект на выполнение командой Simulate>Simulate. 
6. Установить выход для вывода значения  мощности (Out), вы-

брав единицы измерения dbm (рис. 8). 
 

 
Рис. 8. Установка вывода спектра выходной мощности 
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Спектр мощности на выходе усилителя приведен на рис. 9. Мар-
кер (Marker) установлен на частоте сигнала. 

 

Рис. 9. Спектр мощности выходного сигнала 
 

Определение точки компрессии усилителя (P1дБ) 
Последовательность действий по определению точки компрес-

сии: 
1. Выбрать и разместить на схеме специализированный кон-

троллер анализа командой Simulation_XDB>XDB. Установить значе-
ние частоты Freq=0.5 GHz и количество гармоник Order=5. Выбрать  
опцию XdB. 

2. В поле Gain compression занести величину, по которой оцени-
вается сжатие динамической характеристики (по умолчанию – 1 дБ). 

3. Под опцией Port numbers установить номера входного и вы-
ходного портов (обычно Num = 1 и Num = 2 соответственно). 

4. Под опцией Port frequencies установить значения входной и 
выходной частот. В данном случае выходная частота соответствует 
входной и равна 0.5 GHz (рис.10). 

5. Запустить проект на анализ (Simulate>Simulate). 
Окончательный вариант схемного проекта приведен  на рис.11. 
6. Установить табличный вывод параметров inpwr (точка ком-

прессии по входу) и outpwr (точка компрессии по выходу), как пока-
зано на рис. 12. 
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Рис.12.  Вывод рассчитанных значений компрессии 

 
Оценка точки интермодуляции 3-го порядка 
Последовательность действий по определению точки интермо-

дуляции: 
1. Для удобства параметризации схемы разместить блок описа-

ния переменных Var, как показано на рис.13. 
2. На вход усилителя подключить источник многочастотного воз-

действия Pn_Tone из группы Sources_Freq Domain  (рис.14) и парамет-
ризовать его переменными частотами и мощностью, указанными в бло-
ке Var. 
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Рис. 13. Задание параметров входных сигналов: RF0 – центральная 
частота; Space – величина расстройки частот; 

RF1, RF2 – частоты двухсигнального входного воздействия; 
Pin= − 50 dbm −  мощность сигналов 

 
 

 
 

Рис.14. Подключение двухчастотного источника входной мощности 
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3. Разместить  контроллер гармонического баланса НВ и опреде-
лить базовые частоты как RF1 и RF2 с учетом не менее трех гармоник 
по каждой частоте (параметр Order) (рис.15). 

 
 

Рис.15. Параметризация контроллера гармонического баланса 
 

Окончательный вариант схемного проекта приведен на рис. 16. 
 

 
 

Рис.16. Схемный проект для спектрального анализа в режиме двухчастотного 
 входного воздействия 
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4. Запустить проект на анализ (Simulate>Simulate). 
5. Вывести спектр выходной мощности Out и с помощью опции 

Plot Options приложения вывода прямоугольной системы координат 
локализовать спектр в пределах границ RF-2*Space=499.8 MГц и 
RF+2*Space=500.2 МГц и установить маркеры, как показано на 
рис.17. 

 
 

Рис.17. Спектр мощности на выходе усилителя в окрестности входных частот 
 

6. Определить с помощью опции Eqn  уравнение для оценки 
значения точки интермодуляции по выходу  TOI (рис.18). 

 

 
 

Рис. 18. Оценка  параметра TOI 
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7. Выбрать табличную форму вывода. Найти в списке выводи-
мых параметров Datasets and Equations группу Equations, а в ней вы-
брать параметр TOI (рис.19). 
 
 

 

 
Рис.19. Вывод значения TOI 

 
Задание для самостоятельной работы: 
1. Сформировать проект предложенной схемы УВЧ (принципи-

альная схема на дискретных элементах, монолитный усилитель из 
библиотеки и т.п.). 

2. Включить во входную цепь УВЧ полосовой высокочастотный 
фильтр с  полосой пропускания (несколько десятков мегагерц), соответ-
ствующей рабочим частотам усилителя  (можно выбрать из библиотеки 
System Library->Filters). 

3. Определить АЧХ УВЧ (S21). На основании нее определить коэф-
фициент передачи и полосу пропускания УВЧ. Определить односигнальную 
избирательность по зеркальному и прямому каналам для заданных значений 
промежуточной частоты. 
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4. Определить коэффициент шума в полосе и за пределами по-
лосы пропускания. 

5. Определить спектр мощности выходного сигнала. Определить 
коэффициент передачи.  

6. Определить точку компрессии по входу (P1дБ).  
7. Определить точку интермодуляции 3-го порядка по выходу УВЧ.   

 
 
Варианты микросхем усилителей, реализованные в библиоте-

ке САПР ADS (раздел System Library->Amplifiers), для выполнения 
самостоятельной работы: 

1. SA_hp_INA-02186_19930601 
2. SA_hp_MSA-0186_19930601 
3. SA_hp_MGA-86576_19930601 
4. SA_hp_MSA-0886_19930601 
5. SA_qp_QBH-261_19930601 
6. SA_hp_MSA-0786_19930601 

 
 

Содержание отчета: 
 

1. Краткое описание основных характеристик преселектора и УВЧ. 
2. Исходные данные для моделирования и принципиальная схема 

анализируемого устройства. 
3. Проекты и результаты моделирования. 
4. Выводы по каждому пункту проведенных исследований. 

 
 
 

Практическая работа № 2 
 
 

ИССЛЕДОВАНИЕ СМЕСИТЕЛЬНЫХ КАСКАДОВ 
 

 
Цель работы: освоение методики автоматизированного иссле-

дования характеристик смесительных каскадов РПУ. 
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Рис. 20. Функциональная  
модель смесителя 

Основные рассчитываемые параметры:  
− коэффициент преобразования; 
− спектр выходной мощности; 
− АЧХ; 
− спектр выходной мощности. 

 
 

Основные используемые методы и виды анализа: 
− метод гармонического баланса при  двухчастотном воздейст-

вии с опцией метода подпространств Крылова; 
− параметрический метод анализа систем с периодически ме-

няющимися параметрами. 
 

 
 Пример выполнения этапов исследований 
Ниже приведены примеры выполнения оценок основных харак-

теристик смесительного каскада в виде функционального блока. 
 

Пример формирования модели смесителя для спектрального 
анализа в режиме большого сигнала  
Ниже приведена последовательность действий по формированию 

модели смесителя. 
1. Cформировать принципиальную схему устройства или парамет-

ризовать его функциональную модель (Mixer), как показано на рис. 20. 
2. Подключить к сигнальному и гете-

родинному (LO) входам источники мощности 
гармонического воздействия (тип P1_tone 
группы Sources_Freq Domain) и параметри-
зовать их, как показано на рис. 21: 

− частота гетеродина  1 ГГц; 
− частота сигнала 0,95 ГГц; 
− мощность гетеродина + 10 дБм; 
− мощность сигнала -10 дБм. 
3. К выходу смесителя подключить 

нагрузку - Term-компоненту (50 Ом) из 
группы Simulation_HB и присвоить имя 
выходному узлу командой Name Node 
(например, Out), как показано на рис. 22. 



19 
 

 
 

Рис. 21. Подключение сигнального и гетеродинного источников мощности 

 
 

Рис. 22. Подключение нагрузки 

4. Разместить контроллер метода гармонического баланса HB из 
группы Simulation_HB (рис. 23) и установить следующие параметры: 

FREQ[1]=1 GHz (частота гетеродина); 
ORDER[1]=8 (количество гармоник по гетеродину); 
FREQ[2]=0.95 GHz (частота входного сигнала); 
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ORDER[2]=2 (количество гармоник по сигналу); 
MaxOrder=8 (максимальный порядок учитываемых комбина-

ций). 
Установить опцию подключения метода Крылова командой 

Solver>Krylov, предназначенного для повышения эффективности выпол-
нения анализа при большом количестве учитываемых спектральных со-
ставляющих. 

5. Запустить проект на моделирование командой Simulate>Simulate. 
6. Вывести спектр мощности сигнала (dBm) на выходе Out коман-

дой Window>New Data Display. Установить маркер (команда Marker) на 
выходную частоту (рис. 24), соответствующую разности частот гетеро-
дина и сигнала, − 50 МГц. Определить коэффициент преобразования как 
разность между выходной мощностью на промежуточной частоте и 
входной мощностью источника сигнала (в децибелах).  
 

 
 

Рис. 23. Подключение контроллера гармонического баланса 
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Рис. 24. Спектр мощности на выходе смесителя 
 

Пример анализа АЧХ смесителя параметрическим методом в 
малосигнальном режиме по входному сигналу 
Ниже приведена последовательность действий при анализе АЧХ 

смесителя: 
1. Установить значение мощно-

сти входного источника сигнала 
P_LSB=-10 dbm, означающее, что 
частота сигнала в данном случае бу-
дет  меньше частоты гетеродина. Ос-
тальные параметры источника (P, 
Freq) не параметризовать (рис. 25). 
 
 

2. В контроллере  гармонического баланса (HB) выполнить па-
раметризацию: 

− установить частоту гетеродина 1 ГГц и восемь учитываемых 
гармоник, а также подключить опцию Small Signal, что будет означать 
использование параметрического метода (рис. 26). Следует помнить, 
что в данном случае амплитуда входного сигнала не будет влиять на 

Рис. 25. Параметризация входного 
источника 
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нелинейные искажения в смесителе и поэтому мощность сигнала 
должна быть не менее, чем на 20 дБ ниже мощности гетеродина. 

 
 

  Рис. 26. Установка частоты гетеродина в контроллере HB 
 

− установить начальное (1 МГц), конечное (100 МГц) значения 
промежуточной частоты и шаг ее изменения (1 МГц). Включить оп-
цию Use all small-signal frequencies (рис. 27). Cхемный проект для 
проведения анализа приведен на рис. 28.  

3. Запустить проект на анализ (Simulate>Simulate). 
4. В окне просмотра выходных результатов разместить блок  

Eqn и сформировать уравнение для расчета коэффициента преобра-
зования (рис. 29). Здесь SM.OUT[0] – напряжение на выходе на ну-
левой частоте спектра, соответствующей разностной частоте (см. па-
раметр Mix). 
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Рис. 27. Задание частотного диапазона изменения 
промежуточной частоты 

 

 
 

Рис.28. Схемный проект для анализа АЧХ смесителя 

 
Рис.29. Определение коэффициента преобразования 
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5. Вывести  прямоугольную систему координат (рис.30). В поле 
Data Set and Equation выбрать Equation>Kp (ось ординат). Выполнить 
команду Add Vs. Выбрать в качестве независимой переменной сначала 
имя проекта, а затем  переменную ssfreq (ось абсцисс). 

 

 
 

Рис. 30. Определение параметров графика АЧХ 
 

Полученный график частотной зависимости коэффициента пе-
редачи приведен на рис. 31.  
 

 
Рис. 31. АЧХ смесителя 
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Задание для самостоятельной работы: 
1. Сформировать схемный проект СВЧ смесителя на микропо-

лосковых линиях (МПЛ), приведенного ниже (рис. 32) . Для сокраще-
ния времени подготовки можно не включать модели нерегулярностей 
в микрополосковые структуры. 
 

 
 

Обозначение на 
схеме Ширина МПЛ, мм Длина МПЛ, мм 

W1, W4 0,5 2,8 
W2, W3 0,9 2,5 
W5, W6 0,1 2,8 
W7, W8 1,2 2,7 

 
Рис. 32. Схема балансного смесителя и размеры МПЛ 
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 Параметры подложки: диэлектрическая проницаемость  ε  = 9,8;  
высота  H = 0,5 мм. 

Параметры диодов VD1-VD2: ток насыщения – 1 нА; сопротив-
ление потерь – 5 Ом; барьерная емкость при нулевом напряжении 
смещения – 0,012 пФ. 

Исходные параметры источников сигнала и гетеродина: 
− мощность входного сигнала: Рс = -10 дБм; 
− мощность гетеродина:  Рг = +10 дБм;  
− частота входного сигнала: fc = 9,95 ГГц; 
− частота гетеродина: fг = 10 ГГц.  
2. При включении в модель схемы диодов: 
− выбрать диоды из группы компонент командой De-

vice_Diodes>Diode и разместить в топологии схемы (рис. 33); 
− выбрать компоненту Device_Diodes>Diode M  описания  мо-

дели диодов и указать заданные параметры (рис. 34). 
 

 
 
 
 
                    

3. При формировании  микрополосковых структур использовать 
следующие компоненты из группы Tlines-Microstrip: MSub (парамет-
ры подложки); MLin (отрезок МПЛ); MLOC (разомкнутая на конце 
МПЛ); MLSC (замкнутая на конце МПЛ). 

4. Определить спектр мощности на выходе смесителя. Опреде-
лить коэффициент преобразования смесителя и коэффициенты подав-
ления входного сигнала и гетеродина на выходе схемы. 

Рис. 34. Компонента установки пара-
метров модели диода 

 

Рис.33. Топологическая компонента 
диода 
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5. Определить частотную зависимость коэффициента передачи в 
диапазоне изменения промежуточной частоты от 1 до 50 МГц пара-
метрическим методом. Определить полосу пропускания смесителя по 
уровню 3 дБ. 

 
Содержание отчета: 

1. Краткое описание характеристик тракта преобразования час-
тоты. 

2. Исходные данные для моделирования и  схема анализируемо-
го устройства. 

3. Проекты и результаты моделирования по каждому пункту 
проведенных исследований. 

4. Выводы по каждому пункту проведенных исследований. 
 
 
 

Практическая работа № 3 
 
 
ОПРЕДЕЛЕНИЕ ЧУВСТВИТЕЛЬНОСТИ И ИЗБИРАТЕЛЬНОСТИ  
 
 

Цель работы: освоение методики анализа чувствительности 
и избирательности РПУ.  
 
 

Основные рассчитываемые параметры:  
− спектр мощности на выходе тракта промежуточной частоты (ПЧ); 
− чувствительность РПУ; 
− спектр выходной мощности; 
− двухсигнальная избирательность по соседнему каналу. 
 
 
 Основные используемые методы и виды анализа: 
− метод гармонического баланса при двухчастотном воздейст-

вии; 
− метод огибающей. 
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Пример выполнения этапов исследований 
Ниже приведены примеры подготовки проектов в ADS для выполнения 

оценок основных характеристик последовательно включенных каскадов пре-
селектора и тракта промежуточной частоты, представленных в виде функ-
циональных блоков. 
 
 

 Пример функциональной модели схемы супергетеродинного приемника 
для анализа спектра выходной мощности (напряжения), односигналь-
ной  избирательности по немодулированному сигналу 
Модель анализа приведена на рис. 35. 
В состав модели  схемы входят следующие компоненты: 
− полосовой фильтр высоких частот (BPF1); 
− УВЧ из библиотеки (Amp1); 
− смеситель со встроенным гетеродином из библиотеки (Mix1); 
− фильтр промежуточной частоты из библиотеки (S1). 
В контроллере метода гармонического баланса заданы частоты 

гетеродина и сигнала с учетом трех гармоник по каждой частоте в 
комбинациях спектра. 

Выходная мощность оценивается на промежуточной (разностной) 
частоте спектра.  

 
 
Рис.35. Модель для спектрального анализа и оценки односигнальной избирательности 
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Пример проекта схемы для проведения анализа чувствительно-
сти приведен на рис. 36. 

 
 

Рис. 36. Модель для анализа чувствительности 

По сравнению с рис. 35 в схемную модель добавлены следую-
щие компоненты: 

- модулятор с амплитудной модуляцией (MOD1); 
- источник модулирующего синусоидального сигнала (SRC1); 
- согласующий блок сопротивлений (R2-R5), моделирующих сумматор 

сигналов; 
- демодулятор (DEMOD1) с номинальной частотой, соответствующей 

промежуточной частоте. 
В контроллере метода огибающей (Env1) заданы частоты сигнала и 

гетеродина с учетом двух гармоник и интервал анализа 10000 мкс, соответ-
ствующий 100 периодам модулирующего сигнала, достаточный для визу-
альной оценки качества выходного сигнала. Шаг анализа во времени (10 мкс) 
был выбран из соображений точности воспроизведения информационного 
сигнала (не менее 10 точек на периоде). Обязательно в контроллере вклю-
чить опцию turn on noise для генерации собственных шумов. 

После проведения анализа нужно вывести огибающую выходного 
сигнала out на нулевой частоте в базовой полосе частот (Baseband). 
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Уменьшать мощность входного высокочастотного сигнала нужно до 
тех пор, пока не будут наблюдаться искажения формы выходного сигнала. 
В данной схеме чувствительность оценивается для последующей оценки 
избирательности. Для определения инструментальной чувствительности 
согласующий блок на входе нужно убрать.  

Пример проекта для проведения анализа двухсигнальной изби-
рательности с использованием модулированного сигнала и немодули-
рованной помехи приведен на рис. 37.  

В данной модели в контроллере метода огибающей необходимо 
задать три частоты (сигнал, гетеродин и помеха). Шаг анализа во вре-
мени должен обязательно удовлетворять условию Step ≤ 1/(4·|fсигнала 
– fпомехи|). 

Установить мощность сигнала, больше на три дБм значения, 
полученного при анализе чувствительности. Увеличивать мощность 
помехи до тех пор, пока не будут наблюдаться искажения сигнала. 
Избирательность будет равна разности мощностей помехи и сигнала 
в дБм. 

 
 

Рис. 37. Модель для анализа двухсигнальной избирательности 
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Задание для самостоятельной работы: 
1. Сформировать проект предложенной схемы РПУ на основа-

нии схемы преселектора из практической работы № 1, дополнив ее 
трактом ПЧ. Смеситель и ПЧ-фильтр (табл.1) взять из библиотеки  
САПР ADS при согласовании с преподавателем. 

2. Определить спектр мощности выходного сигнала (см. рис. 35).  
Варьируя коэффициент передачи усилителя на выходе тракта ПЧ, до-
биться амплитуды выходного сигнала 500 мВ, что необходимо для 
нормальной работы демодулятора. 

3. Определить чувствительность РПУ (см. рис. 36).  
4. Определить двухсигнальную избирательность по соседнему 

каналу (см. рис.37).  
 

 
Варианты параметров и компонент для проведения исследований 

 
Таблица 1  

Фильтры ПЧ  и канальное разнесение 
№ вари-
анта 

Тип фильтра Центральная 
частота, МГц 

Полоса про-
пускания 

(BW), МГц 

Отстройка 
частоты со-
седнего ка-
нала, МГц 

1 SAWTEK 851539    70   0,155   0,35 

2 SAWTEK 851541    70 0,18 0,4 

3 SAWTEK 851542    70 0,56 1,2 

4 SAWTEK 851543   70 0,82 2,0 

5 SAWTEK 851901 140 0,56 1,5 

6 SAWTEK 851902 140 0,77 2,0 

7 SAWTEK 851903 140 1,04 2,5 

 
Параметры фильтров высокой частоты (ФВЧ) преселектора, 

частоты модуляции и частота ПЧ представлены в табл. 2. 
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Таблица 2  
Параметры фильтров и сигналов 

№ вариан-
та 

Частота сигнала 
и центральная 
частота ФВЧ, 

МГц 

Полоса про-
пускания ФВЧ, 

МГц 

Частота мо-
дуляции, 
кГц 

Частота ПЧ, 
МГц 

1 1200 30    60    70 
2 1500 20    80    70 
3 1800 30 250   70 
4 1900 80 350   70 
5 1000 40 250 140 
6 1600 55 320 140 
7   900 20 450 140 

Типы смесителей: 
1. Mini-Circuit LRMS-2D 
2. Mini-Circuit LRMS-5 
3. Mini-Circuit RMS-5 

 
Содержание отчета: 
1. Краткое описание характеристик тракта ПЧ РПУ. 
2. Исходные данные для моделирования и  схема анализируемо-

го устройства. 
3. Проекты и результаты моделирования по каждому пункту 

проведенных исследований. 
4. Выводы по каждому пункту проведенных исследований. 
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